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Abstract: Technical advances in the field of Brain-Machine Interfaces (BMIs) enable users to control a
variety of external devices such as robotic arms, wheelchairs, virtual entities and communication sys-
tems through the decoding of brain signals in real time. Most BMI systems sample activity from
restricted brain regions, typically the motor and premotor cortex, with limited spatial resolution.
Despite the growing number of applications, the cortical and subcortical systems involved in BMI con-
trol are currently unknown at the whole-brain level. Here, we provide a comprehensive and detailed
report of the areas active during on-line BMI control. We recorded functional magnetic resonance
imaging (fMRI) data while participants controlled an EEG-based BMI inside the scanner. We identified
the regions activated during BMI control and how they overlap with those involved in motor imagery
(without any BMI control). In addition, we investigated which regions reflect the subjective sense of
controlling a BMI, the sense of agency for BMI-actions. Our data revealed an extended cortical-
subcortical network involved in operating a motor-imagery BMI. This includes not only sensorimotor
regions but also the posterior parietal cortex, the insula and the lateral occipital cortex. Interestingly,
the basal ganglia and the anterior cingulate cortex were involved in the subjective sense of control-
ling the BMI. These results inform basic neuroscience by showing that the mechanisms of BMI con-
trol extend beyond sensorimotor cortices. This knowledge may be useful for the development of
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INTRODUCTION

Brain-machine interfaces (BMIs) enable the voluntary
control of external devices through real time decoding of
neural signals. Exploiting either invasive [Carmena et al.,
2003; Fetz, 1969; Hochberg et al., 2012] or non-invasive
techniques [Leeb et al., 2013; Wolpaw and McFarland,
2004], BMIs translate patterns of brain activity into com-
mand signals bypassing the biological corticospinal motor
pathways. In non-invasive BMIs, brain patterns are mainly
recorded using electroencephalography (EEG) while users
are engaged in a cognitive task, such as motor imagery
(MI). This has been defined as a dynamic state during
which a subject simulates an action mentally without any
body movement [Decety, 1996]. In MI-based non-invasive
BMIs (>300 research reports according to PubMed) users
typically imagine performing repeated right or left hand
movements resulting in discriminable patterns that are used
to drive binary decisions (e.g., right-left movements of a cur-
sor or other devices) [Mill�an et al., 2010; Wolpaw et al.,
2002]. In this case, the most commonly used feature is m/b

band suppression over sensorimotor regions [McFarland
et al., 2000; Neuper et al., 2006; Pfurtscheller and Lopes da
Silva, 1999], as these modulations are strongly associated
with both contralateral motor execution and MI. A linear
classifier is typically used to discriminate these spectral EEG
signatures in real-time and translate them into a command
signal.

Although the rapid evolution of brain-controlled sys-
tems has led to a growing interest in the brain mecha-
nisms involved in BMI control, relatively few animal and
human studies have directly investigated the changes in
brain activity associated with the operation of a BMI [Jaro-
siewicz et al., 2008; Koralek et al., 2012]. Recent studies
have confirmed that fronto-parietal and subcortical oscilla-
tions, involved in sensorimotor and visuo-motor processing,
are also recruited during learning to control a BMI [Miller
et al., 2010; Wander et al., 2013]. However, these studies
were not able to address the distributed brain mechanisms
involved in BMI control as they did not provide full-brain
coverage (as is possible with functional magnetic resonance
imaging [fMRI]). Although a number of studies exploiting
the advantages of fMRI have investigated different aspects
of BMI control, results were limited since no real-time feed-
back was provided to the participants [Halder et al., 2011;
Ninaus et al., 2013].

EEG-based BMI control inside of an MRI scanner com-
bines the advantages of real-time BMI control and the high
temporal resolution of EEG with the high spatial resolution

and whole brain coverage offered by fMRI. However, this
approach presents significant technical challenges, which
have hampered attempts to exploit this technique. To date
only two studies successfully investigated the BOLD fMRI
signal while participants controlled an EEG-based BMI.
Hinterberger et al. [2005] used a BMI paradigm (based on
slow cortical potentials) and found strongest activation in
the SMA and premotor cortex during a self-regulation task
as compared to the rest condition. In addition, subcortical
modulations in the basal ganglia and thalamus were associ-
ated with either a positive or a negative shift in the self-
regulated slow cortical potential. In a recently published
study, Zich et al. [2015] investigated the relationship
between the EEG signals and the BOLD response while
subjects controlled a MI-based BMI inside the MRI scanner
with and without feedback. These authors reported a nega-
tive correlation between the power in the l-band and the
BOLD signal in premotor cortex contralateral to the imag-
ined hand movement, and a stronger activation associated
with the visual feedback. However, this analysis was limit-
ed to premotor cortices and did not investigate modulation
outside these areas, that is, what is the network involved in
MI-based BMI control at the full-brain level. Furthermore,
these studies neglected an important aspect of real and
imagined actions, which is the subjective feeling of being in
control over the movement (i.e., the sense of agency [SoA]),
recently investigated for “BMI actions” in a behavioral
study [Evans et al., 2015].

In the present study, we developed an EEG-BMI setup
that is MRI compatible, allowing us to record fMRI data
while human subjects controlled a fully functioning MI-
based EEG BMI in the scanner. We had three main goals for
this study, each one with an associated hypothesis. First, we
wanted to identify the regions active during BMI-control,
and we expected to find activation in a broader network
than the one described in earlier work (i.e., beyond sensori-
motor cortex). Second, we wanted to assess via a meta-
analysis the regions that are consistently active during MI
and compare these with those active during BMI-control.
We anticipated that there would be a marked overlap
between activations during the present BMI task and MI.
Finally, we sought to investigate the neural correlates of the
SoA without the contribution of somatosensory reafference.
As in a previous study on the SoA for BMI actions [Evans
et al., 2015], we manipulated the visual feedback while sub-
jects were engaged in a cursor control task. We expected to
find an overlap with brain regions having been associated
with agency for bodily movement [David et al., 2008], as
well as regions specific for BMI-mediated action.
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MATERIALS AND METHODS

Participants

Sixteen healthy participants (2 females and 14 males,
mean age 25.5 years, SD 6 2.7, range 22–32) took part in
the experiment, which was approved by the Ethics Com-
mittee of the Faculty of Biology and Medicine of the Uni-
versity of Lausanne and was conducted in accordance
with the Declaration of Helsinki. The 16 participants were
selected from an initial pool of 36 subjects, based on their
ability to control a BMI assessed during a recruiting ses-
sion performed outside the scanner.

Experimental Procedure

Participant recruiting session

The recruiting session was aimed at selecting high apti-
tude BMI users who would take part in the BMI-fMRI ses-
sion. During the recruiting session, participants had to
kinesthetically imagine clasping either the left or right
hand to control the movement of a cursor, similar to many
BMI systems based on the spontaneous modulation of the
sensorimotor rhythm (SMR) [Pfurtscheller et al., 1997;
Wolpaw and McFarland, 2004]. Previous studies have
shown that changes in the subject’s posture, from sitting
to a reclined position, can influence brain activity due to
the effects of baroceptive signaling [Lipnicki, 2009; Rice
et al., 2013]. Therefore, to mimic the situation that would
later be encountered in the MRI scanner, the recruiting
session was conducted with the participants laying supine
and viewing the visual stimuli (presented on a video dis-
play) through a 458 inclined mirror placed in front of their
eyes. The session consisted of two parts: during the first
part (off-line) participants performed two runs of MI with-
out visual feedback. During each run of 40 trials, subjects
were asked to imagine clasping either the left or the right
hand. The EEG signal was recorded from 28 electrodes
located over the sensorimotor cortex (see section “EEG sig-
nal acquisition and BMI” for further details). The data were
then used to compute a set of spatial filters (common spa-
tial patterns [CSP], [Blankertz et al., 2008; Guger et al.,
2000]) as well as the coefficients for a binary linear classifi-
er able to discriminate between the two imagined direc-
tions. The classifier computed during this first training
phase was used in the second part of the session for the
on-line control of the cursor, during which the BMI algo-
rithm translated the EEG activity into commands used to
drive the cursor. Participants were instructed to use the
same MI strategy as in the off-line session to operate the
cursor. This session comprised two runs of 32 trials; each
trial ended when the cursor reached the cued edge of the
screen, or after 6 s, whichever came first.

Only subjects with a mean BMI performance above
chance in the recruiting session were retained to take part
into the BMI-fMRI session (see section “BMI-control related

measurements” for details regarding the method used to
obtain the chance threshold). BMI performance was mea-
sured by considering which direction the classifier had
output the majority of the time within one trial.

BMI-fMRI session

Setup. During the BMI-fMRI session, participants laid
supine in the MR scanner holding a button response pad
in each hand, while the EEG signal was simultaneously
acquired. Visual stimuli were projected onto a translucent
screen positioned at the end of the bore and subjects
looked at it through an inclined mirror attached to the
head coil.

Stimuli. The experiment included two off-line and two
online runs. As in the recruiting session, the experiment
began with the off-line runs, during which the subject per-
formed MI without visual feedback while the EEG signal
was recorded. No fMRI data were acquired during the off-
line runs. This step was required to compute the spatial
filters (CSPs) and classifier parameters to be used during
the fMRI recording session.

After the initial motor-imagery task and off-line classifi-
er training, the subject had a short break during which an
anatomical MRI scan was acquired and then the on-line
testing session began. During this session, the visual feed-
back was presented in the form of a rectangular cursor
that moved toward the left or right side of the screen
depending on the classifier output. On half of the trials,
the visual feedback was experimentally manipulated by
reversing the direction of the cursor movement (deviated

trials). Therefore, the online runs included four experimen-
tal conditions arranged in a 2 3 2 factorial design with
cue direction (left/right) and feedback manipulation (unde-

viated/deviated) as factors. The four experimental condi-
tions were randomly intermixed across trials. There were a
total of 64 trials divided into two runs, each comprising
eight repetitions per experimental condition. Each trial
began with the presentation of a fixation cross (2 s) fol-
lowed by a central arrow (1 s), pointing either to the left
or to the right, indicating the side of the screen toward
which the subject should attempt to move the cursor (Fig.
1A). For the next 6 s, the subject was allowed to perform
MI and attempt to move the cursor all the way to the cued
side of the screen. If the cue reached the side of the screen,
then the cursor disappeared and a fixation cross was dis-
played for the remaining time. At the end of the 6-s, peri-
od of cursor control subjects had to report whether or not
they had felt in control of the cursor movement by press-
ing the button on either the right- or left-hand response
pad. The specific response hand used was counterbalanced
across subjects. The response period (3 s) was followed by
6 s of rest. The total duration of each trial was 18 s (Fig.
1A). The total duration of the BMI-fMRI session was on
average 3:30 h, from the subject preparation until the end
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of the fMRI acquisition session. This relatively long dura-
tion prevented the acquisition of a greater number of trials.

Two full-brain volumes of fMRI data were acquired per
trial, one at the beginning of the trial, simultaneous with
the fixation cross, and a second one immediately after the
cursor control period, exactly 9 s after the first volume
acquisition (Fig. 1C). We chose not to acquire volumes
during the cursor control period to avoid compromising
the EEG signal quality with an MR gradient artifact. See
“Magnetic resonance imaging” section below for further
details.

The velocity of the cursor was adjusted for each subject
to avoid a premature termination of the trial (the cursor
reaching the edge of the screen). This was done to ensure
that the subject was performing MI throughout the entire
trial, so that the acquisition of the relevant fMRI volume
would sample the accompanying brain activity (if the cur-
sor were to reach the edge of the screen too quickly, then
the subject might consider the trial as finished and disen-
gage from the task).

EEG Signal Acquisition and BMI Loop

Participant recruiting session

A 64-channel EEG system (g.tec medical engineering
GmbH, Graz, Austria) was used for the recruiting session
performed outside the scanner. The BMI loop, which refers
to the processing chain from the decoding of brain activity
to the feedback presentation, used a subset of 28 of the 64
EEG channels. This subset included all the electrodes situ-
ated over the sensorimotor cortex, with the exception of
C2, C1, and FCz, and also P4, P3, Pz, and Fz. This

particular configuration was imposed by the channel avail-
ability in the MR-compatible cap used during the experi-
ment inside the scanner. The ground was located on the
forehead and the reference was placed on the right earlobe.
During this session, the EEG signal was sampled at 256 Hz.

BMI-fMRI session

During the BMI-fMRI session, the EEG signal was acquired
using a 64 channel MR-compatible EEG system (BrainProd-
ucts GmbH, Gilching, Germany). Electrode AFz was used as
the ground and FCz was used as the reference. The raw sig-
nals were recorded at 5 kHz using proprietary software
(Recorder, BrainProducts), corrected for the magnetic-field-
gradient artifact on-line (RecView, BrainProducts), using an
approach based on template subtraction [Allen et al., 2000],
down-sampled to 200 Hz, and finally sent to a laptop dedi-
cated to on-line classification through Ethernet communica-
tion. The maximum delay between one recorded sample and
the classifier output was 110 ms. The same 28 channel config-
uration used in the recruiting session performed outside the
scanner was also used for the on-line BMI control.

BMI loop

For all BMI sessions, whether inside or outside the scanner,
the BMI control loop was based on the CSP algorithm
[Blankertz et al., 2008; Guger et al., 2000]. This method com-
prises two steps: a calibration and a feedback phase.

Calibration. The calibration phase uses the EEG data
acquired during the offline session to compute the classifi-
er parameters required for the on-line cursor control. First,
the EEG data (offline) were visually inspected to discard

Figure 1.

Procedure. (A) Experimental paradigm. (B) EEG data were recorded for the entire duration of

the experiment. (C) Two fMRI scans were acquired for each trial, the first during the presenta-

tion of a fixation cross and the second after the 6 s of on-line brain-machine interface (BMI) cur-

sor control.
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trials containing ocular or muscle artifacts. The retained
EEG data were band-pass filtered between 8 and 30 Hz, to
include the l (8–12 Hz) and b (12–30 Hz) frequency bands,
and then used to compute the CSPs for the two classes of
imagined movement. The CSP algorithm finds spatial fil-
ters (in the same number as the electrodes) that maximize
the variance for one class while minimizing the variance
for the other class. The variance of the band-pass filtered
signal is proportional to the band power of the signal: as
MI induces patterns of activity, specific for each of the two
imagined direction (i.e., a prominent contribution from
electrodes located in the hemisphere contralateral to the
imagined direction), the signal variance in the frequency
band exploited for the BMI directly reflects the presence of
the above mentioned patterns of activity. Based on the
projection matrix computed with the CSP method [see for
details Guger et al., 2000], the first two CSPs will carry a
prominent contribution from one class, while the last two
CSPs will account for the other class. The use of these four
CSPs to construct the feature vector constitutes a well-
established standard in BMI applications, motivated by
previous studies indicating four as the optimal number of
CSP in a 2-class paradigm [M€uller-Gerking et al., 1999].
Lastly, these four subject-specific features were used as the
input vector for the linear classifier (LDA classifier).

Feedback. In the feedback phase, the EEG data are decoded
in real time to control the movement of the cursor on the
screen. As during the calibration phase, the EEG data were
band-pass filtered in the l and b frequency bands (8–30 Hz)
and then projected onto the first and last two CSPs.

The variance across time of this filtered signal was com-
puted and then log-transformed to normalize the signal
distribution. Based on the sign of the linear classifier out-
put, at each time step one sample was attributed either to
the left or the right-hand class; thus, the cursor position
was updated either to the left or to the right relative to the
current position. The velocity of the cursor was propor-
tional to the distance of the feature vector from the linear
decision boundary and sampled from a range of 10 dis-
crete values for which the sign determines the direction of
movement. In the experiments conducted inside the scanner,
the visual feedback was manipulated on half of the trials
chosen at random. During these incongruent trials (deviated
trials), the sign of the classifier output was inverted thus
reversing the direction of cursor movement with respect to
the motor-imagery EEG signal. This was done to experimen-
tally manipulate, in our participants, the subjective feeling
of being in control over the cursor movement.

Magnetic Resonance Imaging

The MRI data were acquired on a 3T Siemens Trio MR
system (Siemens Medical, Erlangen, Germany), equipped
with a 12-channel coil. Functional images were obtained
using an echo-planer imaging sequence (repetition time
[TR] 5 9 s, echo time [TE] 5 30 ms, field of view

[FoV] 5 192 mm, flip, angle 5 908) and comprised 36 slices
(in-plane resolution 3 3 3 mm2, thickness 3 mm, gap
0.3 mm) acquired in interleaved order and covering entirely
the cerebral hemispheres.

The acquisition of each volume was packed within the
first 2 s of the TR, allowing a silent period of 7 s between
two consecutive acquisitions. This method, combined with
the experimental design, allowed the participant to control
the cursor via the BMI control loop using the EEG signal
acquired when the scanner was silent. With such a long
TR, we acquired two images per trial: the first was
acquired during the cue presentation, reflecting the activi-
ty during rest; the second was acquired at the end of the
cursor control period, reflecting the activity during MI.

During the training of the BMI classifier after the two
off-line runs inside the scanner, a sagittal T1-weighted 3D
gradient-echo sequence (MP2RAGE) [Marques et al., 2010]
was acquired for each subject (160 contiguous sagittal slices,
slice thickness 1 mm, matrix size 240 3 256, FoV 5 256 mm,
flip angle 5 08, with TE 5 2.63 ms, TR 5 7.2 ms, TI1 5 0.9 s,
TI2 5 3.2 s, TRmprage 5 5 s).

BMI-Control Related Measurements

To obtain a bias-free estimate of subjects’ ability to con-
trol the BMI, we computed BMI-control performance using
the area under the curve (AUC, values range [0-1]). The
AUC refers to the area under the receiver operating charac-

teristic, here computed by labeling each trial according to
the class (right or left) assigned by the classifier for the
majority of samples. A hit was assigned if this label
matched the cued direction. The AUC offers the advantage
of being less affected by a possible classification bias
toward one of the two directions. Importantly, this mea-
sure is obtained based on the raw classifier output, inde-
pendently of the presence of the experimental deviation in
the cursor trajectory.

Furthermore, to identify which subjects achieved suc-
cessful BMI-control, we used the binomial cumulative dis-
tribution, a method previously proposed to identify the
statistical significance threshold for BMI control [Combris-
son and Jerbi, 2015; M€uller-Putz et al., 2008]. This empiri-
cal approach takes into consideration the number of trials
performed by the subject, as previous studies pointed out
that for a two-class BMI paradigm, the theoretical chance
level of 50% only holds for an infinite number of trials
[Combrisson and Jerbi, 2015]. In our case, based on the
number of trials in our paradigm (32 trials per class), the
threshold for statistical significance was found to be
around 61% at P< 0.05 (corresponding to an AUC value of
�0.61, assuming the same number of instances of both
classes). It is important to note that only subjects whose
BMI performance exceeded this threshold during the par-

ticipant recruiting session outside the MRI scanner, were
invited to participate in the second session.
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During the BMI-fMRI session, subjects had to report at
the end of each trial whether or not they had felt in con-
trol of the cursor movement, by answering the question:
“Did you feel that you were the one controlling the
cursor?” The answer (YES/NO) was collected by means of
two MRI compatible button pads (Current Designs, Phila-
delphia, PA), one in each hand. Subjects were instructed
to hold the pads in their hands while keeping the palms
facing up, throughout the entire duration of the experi-
ment. The association between the answer and the hand
used to answer was counterbalanced across subjects to
control for motor preparation.

Data Analysis

Electrophysiological correlates of MI

To ensure that our subjects were performing MI, we
analyzed the EEG signals for signs of suppression of the
well-known sensorimotor m-rhythm [Pfurtscheller and
Lopes da Silva, 1999], which is associated with MI over
the hemisphere contralateral to the imagined hand move-
ment. We used the data collected during the offline session,
without visual feedback, and investigated modulations in
the l-band power spectrum (event related spectral perturba-
tion, ERSP, [Makeig, 1993]), separately for right and left MI,
that is, electrodes C3 and C4, over the last 4 s of a total of
6 s of MI. We discarded the first 2 s since this time window
could contain artifacts related to eye movements. We consid-
ered as a baseline the first 2 s at the beginning of each trial
prior to the MI period, during which we presented the fixa-
tion cross and the cue indicating which hand had to be
imagined. Separately for each of the two imagined direc-
tions, we then compared the l-rhythm over electrodes C3
and C4 and tested (two tailed paired t-test) for the presence
of significantly stronger power suppression over C3 during
right MI and over C4 during left MI.

Common spatial patterns

The CSPs offer a neurophysiologically meaningful
insight into the topographical properties of SMR. Each
CSP is a weighted combination of the EEG electrodes,
and thus the higher the value assigned to a given elec-
trode, the stronger the contribution of the underlying
neural activity in classifying between the two imagined
directions. One can expect to find a lateralized peak of
activity over the sensorimotor areas, contralateral to the
imagined hand movement [Blankertz et al., 2008]. There-
fore, as a first step in the analysis of the EEG data, we
inspected the CSP computed at the beginning of the
experiment in the fMRI. More specifically, we looked at
which electrode, of the first and last CSP (Fig. 2) was
weighted the most heavily in the classification, expecting it
to be found over the hemisphere contralateral to the imag-
ined hand movement.

BMI performance

We tested whether subjects’ performance (AUC) changed
between the two sessions (recruiting and BMI control inside
the MR scanner), between deviated and undeviated trials, and
between “control” and “no-control” trials (i.e., depending
on whether the subject reported feeling him or herself to be
in control over the cursor movement). We further investi-
gated the relationship between BMI performance and the
reported feeling of control across subjects by computing the
correlation between BMI performance and the percentage of
trials in which the subject reported feeling in control, sepa-
rately for undeviated and deviated trials.

fMRI data analysis

The fMRI data were pre-processed using SPM8 (Well-
come Department of Cognitive Neurology, London, UK).
Of the 16 subjects selected to participate in the fMRI
experiment, data from four subjects had to be discarded:
three subjects asked to withdraw from the experiment
partway through, and the fMRI data for one subject were
contaminated with presence of artifacts in the fMRI
images, leaving N 5 12 subjects. Functional scans were first
realigned spatially to the first volume acquired and in
time to the first slice acquired. After realignment, volumes
were normalized to the Montreal Neurological Institute
(MNI) template, resampled to a voxel size of 3 3 3 3

3 mm3, and smoothed with an isotropic Gaussian kernel
(6 mm full width at half maximum).

Structural volumes were co-registered with the function-
al volumes, normalized to the MNI template brain, and
resampled to a 1 3 1 3 1 mm3 voxel size.

Two spatial analyses were conducted to investigate the
different brain mechanisms underlying the control of a
BMI. Active areas during each condition were assessed
with a general linear model using the canonical hemody-
namic response function as the basis function. Inference at
the population level (group analysis) was obtained by
means of second-level statistics based on random field the-
ory [Friston et al., 1994].

To investigate the activity elicited by BMI control and
by the effect of the congruence of the visual feedback, we
performed a 2 3 2 repeated-measures analysis of variance
(ANOVA) with “cue direction” (left/right) and “cursor
movement manipulation” (undeviated/deviated) as within-
subject factors.

We first investigated the average brain response to the
four experimental conditions regardless of the cue direction
and of the movement manipulation (q< 0.05 FDR corrected,
30-voxel cluster threshold) and checked its consistency with
the results of a meta-analysis (see “Results” section) of prior
MI imaging studies conducted in healthy subjects. Then,
differences in BOLD signal intensity related to the cue
direction and to the cursor movement manipulation were
investigated (q< 0.05 FDR corrected, 30-voxel cluster thresh-
old). Finally, we tested whether activations in those clusters
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showed different trends (i.e., activation or deactivation)
depending on the cued direction. For each sensorimotor
cluster found in the previous analysis, we extracted the
mean beta values obtained by contrasting separately the
right and left motor-imagery scans against the “rest” scan.

The second analysis investigated which brain areas were
involved in the subjective feeling of control over the move-
ment of the cursor. To address this question, we reanalyzed
the fMRI data with a 2-way repeated-measures ANOVA,
with “cue direction” (left/right) and “feeling of control”
(YES/NO) as within-subjects factors. We investigated the
brain areas associated with the reported feeling of control by
contrasting the “control” versus “no control” trials (q< 0.05

FDR masked with the regions showing a significant response
to at least one experimental condition at P< 0.001, clusters
with a spatial extent of at least 30 contiguous voxels).

All clusters were anatomically labeled using the probabil-
istic cytoarchitectonic maps defined in the SPM Anatomy
Toolbox (version 1.8) [Eickhoff et al., 2009].

Meta-analysis of hand MI studies

We computed a meta-analysis of prior fMRI MI studies
conducted in healthy subjects to test the consistency of our
results with previous MI studies. The meta-analysis was
performed using the BrainMap software (Research

Figure 2.

Electrode configuration and Common spatial patterns. (Top) The 28-electrode subset highlighted

with white circles is used for BMI loop out of a 64-channel MRI-compatible cap (10–20 configu-

ration). (Bottom) CSP for right and left motor imagery in three representative subjects. Subjects

S1 and S2 show the stereotypical patterns of activation associated with motor-imagery based

non-invasive BMIs. [Color figure can be viewed at wileyonlinelibrary.com]
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TABLE I. Neuroimaging studies included in the ALE meta-analysis of neuroimaging studies of hand motor imagery

Publications Subjects Contrast
Number of
Locations

Imaging
Modality

[Binkofski et al., 2000] 6 Imagery of Somatosensory Guided Movement vs. Rest 6 fMRI
Imagery of Visually Guided Movement vs. Rest 8

[Boecker et al., 2002] 6 Sequences I to V Combined>Rest 11 PET
Sequences I to V Combined<Rest 6
Positive correlation with sequence complexity 5
Inverse correlation with sequence complexity 5

[Creem-Regehr and Lee, 2005] 12 Tools> Scrambled Tools, Imagined Grasping 15 fMRI
Scrambled Tools>Tools, Imagined Grasping 5
Shapes> Scrambled Shapes, Imagined Grasping 13
Scrambled Shapes> Shapes, Imagined Grasping 9
Tools> Shapes, Imagined Grasping 5

[Decety et al., 1994] 6 Motor Imagery - Visual Inspection 34 PET
Motor Imagery - Movement Observation 52

[Ehrsson et al., 2003] 7 Imagined Finger - Imagined Toe Movement 3 fMRI
Imagined Finger - Imagined Tongue Movement 3
(Imagined Finger - Imagined Toe Movement) 1 (Actual Finger -

Actual Toe Movement)
3

(Imagined Finger - Imagined Tongue Movement) 1 (Actual Finger
- Actual Tongue Movement)

3

Imagined Finger Movement - (Imagined Toe 1 Imagined Tongue
Movement)

3

Imagined Toe Movement - (Imagined Finger 1 Imagined Tongue
Movement)

2

Imagined Tongue Movement - (Imagined Finger 1 Imagined Toe
Movement)

3

[Filimon et al., 2007] 15 Imagined Reaching>Passive Viewing 13 fMRI
Actual Reaching 1 Observed Reaching 1 Imagined Reaching 3

[Gerardin et al., 2000] 8 Motor Imagination vs. Rest 20 fMRI
Motor Imagination vs. Motor Execution 15

[Grafton et al., 1996] 7 Imagined Grasping>Object Viewing 12 PET
[Guillot et al., 2009] 9 50 Visual Imagery vs. Passive Listening 34 fMRI

Kinesthetic Imagery vs. Passive Listening 44
Visual Imagery vs. Kinesthetic Imagery 9
Kinesthetic Imagery vs. Visual Imagery 18

[Hanakawa et al., 2008] 13 Finger Tapping, Imagery 12 fMRI
Finger Tapping, Imagery 1 Finger Tapping, Movement 18
Finger Tapping, Imagery>Finger Tapping, Movement 4
Finger Tapping, Imagery> Instructional Cue 10

[Harrington et al., 2007] 11 Write>Rest 13 fMRI
Draw>Rest 22
Draw>Write 16

[Johnson et al., 2002] 8 Left Hand Preparation 28 fMRI
Right Hand Preparation 30
Left Hand Grip Selection 7
Right Hand Grip Selection 13

[Jueptner et al., 1997] 12 Imagine vs. Rest 2 PET
[Kuhtz-Buschbeck et al., 2003] 12 Motor Imagery, Simple, Right Hand vs. Baseline 5 fMRI

Motor Imagery, Complex, Right Hand vs. Baseline 12
Motor Imagery, Simple, Left Hand vs. Baseline 7
Motor Imagery, Complex, Left Hand vs. Baseline 13
Imagery>Execution, Right Hand 4
Imagery>Execution, Left Hand 1

[Lacourse et al., 2005] 54 Novel, Image vs. Rest 16 fMRI
Skilled, Image vs. Rest 16
Novel, Image>Move 2
Skilled, Image>Move 5
Novel> Skilled, Image 8

r Marchesotti et al. r

r 2978 r



Imaging Institute of the University of Texas Health Science
Center San Antonio; http://brainmap.org/ Laird et. al
2009) and in accordance with the methods described by
Laird et al. [2005] and modified later by Eickhoff et al.
[2009]. A total of 21 fMRI and PET studies (see Table I)
involving hand MI tasks were selected from the BrainMap
database using the Sleuth software (Sleuth, BrainMap).
The peak locations found in these selected studies were
then converted into a probabilistic image using dedicated
software (GingerALE, BrainMap) using the activation like-
lihood estimation (ALE) technique. Briefly, the ALE
approach works by modeling each focus with a 3D-
gaussian probability distribution centered at the given
location with a standard deviation inversely proportional
to the number of subjects of the study, and then the union
of the activation probabilities is computed at each voxel to
derive the ALE map of the study [Eickhoff et al., 2009].
We finally tested whether and where the ALE maps were
significantly different from zero (q< 0.05 FDR corrected,
minimum cluster size of 100 mm3), indicating a conver-
gence of the results of the selected imaging studies. To test
the consistency of the results of our BMI maps with the
previous studies on hand MI, we explored the overlap
between the results of the meta-analysis and the average
brain response to the four experimental conditions
obtained with the first ANOVA described above (q< 0.05,
FDR corrected, 30-voxel cluster threshold).

RESULTS

EEG Data: Electrophysiological Correlates of MI

The EEG data recorded during the offline part of the
recruiting session and during the BMI-fMRI session exhibited
a modulation of l-band power that is classically observed
during MI. For this, we considered the EEG signal over C3
and C4 separately for each of the two imagined directions
and expected a stronger l-band suppression for the electrode
located over the contralateral hemisphere with respect to the

imagined direction [i.e., Pfurtscheller and Neuper, 1997]. We
observed that the C3 signal exhibited a significantly stronger
suppression for rightward cursor control with respect to C4
(two tailed paired t-test, recruiting session: t 5 2.86, P< 0.05;
cursor control inside the scanner: t 5 2.47, P< 0.05, Fig. 3). Simi-
larly, leftward cursor control was associated with a signifi-
cantly stronger suppression over electrode C4 than over C3
(recruiting session: t 5 4.26 P< 0.005; cursor control inside the

scanner: t 5 2.45, P< 0.05, Fig. 3). The analysis of l-band sup-
pression confirmed that we were able to record classical EEG
signatures of hand MI during BMI control, even when the
EEG data were recorded inside the MRI scanner.

EEG Data: Common Spatial Patterns

We computed CSP topographies for each experimental
session (recruiting session; BMI-fMRI session) based on the
training data. Analysis confirmed that the four most dis-
criminant CSPs, two for each imagined direction (extracted
from data recorded during both sessions) exhibited the ste-
reotypical patterns of EEG-activity commonly associated
with motor-imagery based non-invasive BMIs (Fig. 2) [Blan-
kertz et al., 2008; Guger et al., 2000]. This was found for the
majority of our subjects (10 out of 12 subjects). We also
extracted the maxima of both the right and left spatial pat-
terns, computed for the recruiting and the BMI-fMRI ses-
sions separately to examine whether the electrode showing
the strongest contribution to classification was located over
the contralateral hemisphere with respect to the direction of
cursor movement in both sessions. This was the case in ten
of the twelve subjects tested for the recruiting as well as for
the BMI-fMRI session (in the remaining two subjects, both
maxima were located over the same hemisphere).

EEG Data: BMI-Control Performance

Only subjects exhibiting BMI-control performance above
the empirical chance threshold (corresponding to an AUC

TABLE I. (continued).

Publications Subjects Contrast
Number of
Locations

Imaging
Modality

[Lamm et al., 2007] 17 Reaching Range Predictions/Averaged>Gender Matching 20 fMRI
Correlation between Reaching Range Prediction>Baseline 6

[Seitz et al., 2000] 6 Right Finger Imagery 6 fMRI
[Servos et al., 2002] 12 Arm Motor Imagery 2 fMRI
[Stephan et al., 1995] 6 Imagined Movement vs. Motor Preparation 26 PET

Imagined vs. Executed Movements 3
[Szameitat et al., 2007a] 15 Imagery>Fixation 11 fMRI

Imagine Upper Extremity Movements - Fixation 13
Imagine Whole Body - Upper Extremity Movements 5

[Szameitat et al., 2007b] 17 Right – Rest 23 fMRI
Left – Rest 24

Abbreviations: fMRI: functional magnetic resonance imaging, PET: positron emission tomography.

r Neural Correlates of BMI-Control r

r 2979 r

http://brainmap.org


value of �0.61) during the training session, were allowed to
participate in the BMI-fMRI session. In this latter session,
the majority of our participants (8 out of 12 subjects) did
perform above chance (Fig. 4). In particular, in the session
inside the MRI scanner, we observed a high variance in per-
formance, ranging from 0.5 to 1. Furthermore, comparing
participants’ performance between the two sessions revealed
a significant decrease in performance during the session per-
formed inside the fMRI scanner (two-tailed paired t-test,
t 5 3.15, P< 0.01). This decrease is likely due to the discom-
fort of the MRI environment reported by some of our

subjects and that lead to two subjects withdrawing from the
experiment part way through. This decrease is comparable
with the drop in performance inside the MRI scanner
recently reported by Zich et al. [2015].

However, unlike this previous study, in our experiment
the average BMI control performance across subjects was
found to be above chance during both sessions (training
session: 0.89, SD 6 0.11, BMI-fMRI session: 0.78, SD 6 0.19).

Significant difference in AUC was observed neither
between deviated and undeviated trials nor between “control”
and “no control” trials.

Figure 3.

Sensorimotor rhythm suppression. Modulation of l-rhythm suppression over sensorimotor regions

during left and right hand motor imagery over electrodes C3 and C4. In both the training session

outside the scanner and the cursor control inside the MRI, a statistically significant stronger power

suppression is shown over the electrode placed contralateral to the imagined hand movement.

[Color figure can be viewed at wileyonlinelibrary.com]

Figure 4.

BMI-control performance inside and outside of the MRI scanner.

Single-subject BMI-control performance are shown for the ses-

sion outside (training session, blue dots) and inside (BMI-fMRI

session, red dots) the MRI scanner. The gray area indicates

performance that did not exceed the empirical chance threshold

of 0.61: out of a total of 12 subjects, 4 participants did not per-

form above chance during the BMI-fMRI session. [Color figure

can be viewed at wileyonlinelibrary.com]
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fMRI Data: Brain Regions Activated during BMI

Control and in Comparison to Those of MI

The results of the fMRI analysis investigating the
regions involved in online BMI control revealed an

extended brain network that not only involved predomi-
nantly the sensorimotor regions but also included areas
not reported before as being recruited during MI or BMI
(Fig. 5). The experimental conditions were found to acti-
vate (thresholded at q< 0.05 FDR corrected) a large

Figure 5.

BMI-related BOLD response. Group results showing the average brain response to the four

experimental conditions irrespectively of the cue direction and of the movement manipulation

(P< 0.05 FDR).

TABLE II. Activations during BMI control

Cluster number Cluster size (voxels)

Peak MNI Coordinates (mm)

Anatomical locationT x y z

1 5638 9.78 236 24 52 Left Precentral Gyrus
8.94 45 267 1 Right LOC
8.82 48 21 55 Right Middle Frontal Gyrus
8.12 33 20 4 Right Anterior Insula Lobe
7.44 248 273 4 Left LOC
7.06 36 27 55 Right Precentral Gyrus
6.71 57 234 22 Right Superior Temporal Gyrus (TPJ)
6.69 33 21 67 Right Superior Frontal Gyrus
6.62 12 8 22 Right caudate nucleus
6.21 23 24 58 Supplementary motor area
6.18 260 8 13 Left Frontal Operculum
5.61 233 17 10 Left Anterior Insula Lobe
5.29 54 11 16 Right Frontal Operculum
5.05 26 8 22 Left caudate nucleus
3.44 221 11 1 Left Putamen

2 118 4.78 36 261 229 Right Cerebellum - Crus I (Hem)
4.03 27 267 226 Right Cerebellum - Lobule VI (Hem)

3 41 4.62 233 255 232 Left Cerebellum - Lobule VI (Hem)
4 103 4.2 215 267 55 Left Superior Parietal Lobule
5 33 3.87 215 270 223 Left Cerebellum - Lobule VI (Hem)

3.77 23 279 217 Left Cerebellum - Lobule VI (Vermis)
6 97 3.5 239 243 58 Left Superior Parietal Lobule

r Neural Correlates of BMI-Control r

r 2981 r



network consisting of the bilateral premotor cortex (PMC)
and primary motor cortex (M1), SMA, bilateral superior
parietal cortex, bilateral frontal operculum, right superior
temporal gyrus, bilateral anterior insula, bilateral lateral
occipital cortex (LOC), and cerebellum. In addition, the
bilateral caudate nucleus and left putamen were also acti-
vated by the BMI control task with respect to rest. The ste-
reotaxic coordinates of the maxima of each activated
cluster are reported in Table II. These data show that
strong activations were not only observed in expected
motor and premotor areas but also that several different
areas outside motor cortex were involved in BMI control.

To compare the brain regions associated with online
BMI control (Figs. 5 and 6A) with those reported during
MI, we conducted a meta-analysis of 21 neuroimaging
studies (Table I) that used hand MI paradigms (and were

thus comparable to the MI paradigm used in the present
study, although the exact task instructions and require-
ments differed among these studies and with respect to
the present BMI study). This meta-analysis of hand MI
revealed activation of the bilateral SMA, the PMC, the
primary motor and somatosensory cortices, the bilateral
frontal operculum, the bilateral superior and inferior parie-
tal lobule, middle cingulate cortex, bilateral insula, bilater-
al putamen, caudate and pallidum, left thalamus, and
cerebellum (Fig. 6B, Table III). Directly comparing both data-
sets (present data on BMI control; MI data from meta-analy-
sis) we found common activations (Fig. 6C) in many, but
not all, regions activated during BMI control. Commonly
activated were the bilateral PMC, SMA, bilateral frontal
operculum, bilateral insula, bilateral superior parietal lobule,
left inferior parietal lobe, right and left putamen, right

Figure 6.

Comparison between BMI-activity and MI meta-analysis results. (A) Activation found considering

the positive effect of all experimental conditions (P< 0.05 FDR, red). (B) Results from the meta-

analysis on hand motor imagery (P< 0.05 FDR, green). (C) Overlap between the two contrasts

(yellow). [Color figure can be viewed at wileyonlinelibrary.com]
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caudate, and cerebellum. The bilateral lateral occipital com-
plex and the right supramarginal gyrus were only activated
during online BMI control, whereas the thalamus was found
only during hand MI (meta-analysis). These data provide
additional evidence that the present participants relied on
MI to perform BMI while in the scanner.

fMRI Data: Right versus Left BMI Control

To determine which brain regions were differentially acti-
vated when attempting to move the cursor toward either
the right or the left side of the screen, we contrasted the
fMRI data associated with the right- versus those of the
left-cued direction. This analysis revealed significant differ-
ences that were mainly restricted to the PMC, but also
extended onto the primary motor cortex (Fig. 7A, q< 0.05
FDR corrected). More specifically, when participants were
asked to perform right MI we found a significantly stronger
response in the left motor and premotor cortex, and similar-
ly left MI was associated with a stronger activation in the
same, but contralateral, motor cortices. Furthermore, we
note that the cluster contralateral to the direction of cursor
control showed relatively enhanced activation, whereas the

ipsilateral cluster showed relatively decreased activation
(Fig. 7B). More detailed analysis of the anatomical location
of these clusters revealed that cursor control primarily acti-
vated the contralateral PMC and, to a lesser extent, the con-
tralateral primary motor cortex. The only other region that
exhibited differential activation during right versus left cur-
sor control was the cerebellum, showing a significantly
stronger activation in the right cerebellum during right con-
trol. Additionally, by considering a more liberal threshold
(P< 0.001 uncorrected) when contrasting left versus right
imagery, we observed a stronger activation in the left cere-
bellum (contralateral to the above-mentioned cluster in the
right cerebellum).

fMRI Data: Brain Regions Associated with

Subjective Feelings of BMI Control (Sense

of Agency)

Differences in the feeling of control over the cursor move-
ment between undeviated and deviated trials were assessed
with a two-tailed t-test. In accordance with previous BMI
agency work from our laboratory (carried out outside the

TABLE III. Significant clusters identified by the ALE meta-analysis of neuroimaging studies of hand motor imagery

Cluster number Cluster size (vox)

MNI coordinates (mm)

ALE (3 103) Anatomical locationx y z

1 5493 21 0 59 63.61 Supplementary motor area
238 249 59 57.43 Left Inferior Parietal Lobule
221 24 61 54.43 Left Superior Frontal Gyrus
256 5 30 40.50 Left Inferior Frontal Gyrus (p. Opercularis)

2 792 29 27 55 53.61 RightPrecentral Gyrus
3 554 38 232 44 39.81 Right Postcentral Gyrus
4 482 219 262 58 32.40 Left Superior Parietal Lobule
5 391 52 13 13 32.46 Right Inferior Frontal Gyrus (p. Opercularis)
6 378 222 21 4 26.46 Left Pallidum

226 25 13 26.20 Left Putamen
210 19 8 17.26 Left Caudate Nucleus

7 287 20 6 9 27.53 Right Putamen
22 0 3 24.09 Right Pallidum
16 18 8 16.63 Right Caudate Nucleus

8 239 21 259 60 27.64 Right Superior Parietal Lobule
17 273 52 21.73 Right Precuneus

9 149 21 223 49 28.63 Left Middle Cingulate Cortex
10 108 40 258 236 28.38 Right Cerebellum - Crus I
12 74 261 231 29 24.59 Left Inferior Parietal Gyrus
13 62 230 253 217 17.89 Left Cerebellum - Lobule VI
14 59 230 21 6 21.55 Left Insula Lobe
15 54 10 266 216 23.43 Right Cerebellum - Lobule VI
16 40 22 257 220 18.31 Right Cerebellum - Lobule VI
17 39 66 237 30 20.26 Right Inferior Parietal Lobe
18 31 56 18 213 20.43 Right Temporal Pole
19 28 211 219 9 17.45 Left Thalamus
20 20 248 264 24 18.03 Left Inferior Temporal Gyrus
22 17 240 269 228 18.69 Left Cerebellum - Crus I
25 16 26 248 218 18.31 Left Cerebellum - I-IV
27 14 22 246 24 16.70 Cerebellar Vermis
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fMRI scanner) [Evans et al., 2015], we found that partici-
pants reported a significantly reduced SoA when the cursor
trajectory was deviated (two-tailed paired t-test, t 5 3.57,
P< 0.005). Correlation analysis between BMI performance
and agency judgements revealed a significant positive cor-
relation for undeviated trials (r 5 0.8672, P< 0.0001) and a

significant negative correlation for deviated trials (r 5

20.8911, P< 0.0001), as expected.
To investigate the brain mechanisms associated with the SoA,

we performed a statistical analysis with the within-subjects fac-
tors “cue direction” (left/right) and “feeling of control” (YES/
NO). The main effect of the reported SoA revealed significantly

Figure 7.

Lateralized BMI activations. (A) Group results showing the

effect of the cue-direction (P< 0.05 FDR) over premotor and

motor regions. The cluster over the left hemisphere (red)

shows a higher activation during right MI whereas a stronger

activity due to left MI is depicted in the cluster over the right

hemisphere (blue). (B) Mean beta values over the two clusters

and for the two imagined directions. The hemisphere contralat-

eral to the imagined direction shows a positive mean beta value,

whereas the ipsilateral hemisphere is associated with a negative

value. [Color figure can be viewed at wileyonlinelibrary.com]

Figure 8.

Brain activity associated to the sense of agency for BMI control.

Group results showing regions with stronger activations

(P< 0.05 FDR, masked with Any Effect contrast at P< 0.001)

when subjects reported feeling in control as opposed to not

feeling in control. The activity over the basal ganglia region was

associated with positive BOLD response, unlike the one over

the ACC and the left superior frontal gyrus, which showed a

negative response to the stimulation. [Color figure can be

viewed at wileyonlinelibrary.com]
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stronger activation in the caudate nucleus bilaterally and in
the right putamen for those trials where subjects reported the
feeling of being in control over the cursor movement (SoA),
independently from the cue direction and the experimental
manipulation (q< 0.05 FDR masked with Any Effect contrast
at P< 0.001, clusters with a spatial extent of at least 30 contig-
uous voxels, Fig. 8). Additionally, we found significant clus-
ters located in the anterior cingulate cortex (ACC) and the
left superior frontal gyrus. Follow-up analyses revealed that
the neural activity over these two areas was associated with a
negative BOLD response, unlike the activity over the above-
mentioned basal ganglia region. There were no clusters
showing stronger activation when subjects reported not feel-
ing in control of the cursor compared to when they did.

DISCUSSION

Using simultaneous EEG-fMRI, we were able to uncover
the cortical and subcortical brain regions associated with
different aspects of BMI control. Our paradigm allowed par-
ticipants to control the movement of a visual cursor inside
an MRI scanner, as confirmed by the average BMI-control
performance being significantly above chance and further
corroborated by the classical lateralized l-rhythm suppres-
sion being observed over premotor/motor scalp regions.
We have organized our discussion around the three main
goals of our study: (1) identify the network of regions
involved in BMI control at the whole-brain level and (2)
assess the overlap of these regions with those already
reported as being recruited during pure MI; (3) uncover the
neural correlates of the sense agency for BMI actions.

Regions Active during BMI-Control

Regarding the first of our three hypotheses, we found
bilateral premotor and primary motor cortex and, extend-
ing beyond these areas, we observed several other cortical
structures, along with basal ganglia and cerebellum. Most
EEG-based BMI approaches generally record data over a
specific region of the scalp. For example, MI BMIs com-
monly decode brain signals from electrodes centered over
motor cortex [Hochberg et al., 2012; Pfurtscheller and Neu-
per, 2001; Wolpaw and McFarland, 2004]. Similarly, a
recent neuroimaging study of BMI provided EEG-based
feedback while participants were inside the MRI scanner,
but restricted the analysis to cortical premotor and motor
regions [Zich et al., 2015]. By contrast our approach
allowed us to investigate the network associated with BMI
control across the entire brain. The premotor and motor
areas that we report in the present study (PMC, M1, SMA)
have been consistently reported during MI tasks [Jean-
nerod, 2001; Lotze and Halsband, 2006] and these regions
have been associated with cortical reorganization during
learning to control a BMI [Carmena et al., 2003].

In addition to sensorimotor regions, our data also
revealed an involvement of the posterior parietal cortex

(PPC) as well as insular cortex. Decoding PPC activity has
been used for high-level aspects of action planning, which
can be translated into the control of trajectories and goals of
external devices [i.e., Aflalo et al., 2015]. Furthermore, activi-
ty in PPC was found to be modulated by the acquisition of
expertise in BMI-control [Wander et al., 2013]. Less is
known about the insula’s involvement in BMI control: pre-
vious studies have shown that subjects can successfully con-
trol this area using real-time fMRI-based neurofeedback
[Caria et al., 2007]. We argue that its activation in our para-
digm underlies its hub-like role in integrating sensorimotor
signals due to its strong connection with motor and premo-
tor areas [Cauda et al., 2011], and its involvement in MI
[H�etu et al., 2013; Sacco et al., 2006; Solodkin et al., 2004].
The cerebellum and the basal ganglia also showed marked
activation during on-line BMI control. An extensive body of
literature has focused on the importance of these structures
for motor control [Graybiel et al., 1994] and MI [Decety
et al., 1994; Dominey et al., 1995; Guillot et al., 2008; Jean-
nerod, 2001]. For example, damage to the cerebellum has
been reported to impair MI [Battaglia et al., 2006].

Only three regions—bilateral PMC, M1, and cerebellum—
exhibited differential activation for rightward versus left-
ward cursor control. In line with results from a previous
study that used a similar experimental set-up [Zich et al.,
2015], BMI control of the cursor to either the right or the left
side was reflected in stronger activation of a cluster overlap-
ping the contralateral PMC. The present data show that the
same is true, albeit to a lesser degree, for M1. Although M1
recruitment in MI is controversial, electrocorticographic
(ECoG) recordings have shown prominent M1 activation
during MI-based BMI compared to MI without feedback
[Miller et al., 2010] and activation in M1 has also been asso-
ciated with expertise in MI [Sharma et al., 2008]. The present
data support the involvement of M1 in MI-based BMI con-
trol. In line with previous studies [Yuan et al., 2010; Zich
et al., 2015], we also observed the negative relationship
between beta values in PMC and M1 regions and the m-
band suppression in the EEG over the same areas.

Interestingly, additional differences between right- and
left-hand MI were found in the cerebellum, associating right
MI with ipsilateral right cerebellar activation and left MI
with ipsilateral left cerebellar activation (although the latter
activation did not reach significance after correction for
multiple comparisons). None of the other regions found to
be active during BMI-control discriminated between left
and right hand MI, suggesting that these regions reflect
more basic differences with respect to the control condition
as in non-lateralized MI, visual stimulation, or other cogni-
tive aspects of BMI control such as action planning.

Common and Distinct Brain Activations during

Motor-Imagery and BMI-Control

Regarding our second hypothesis (i.e., an overlap of the
activations previously described with those reported for
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MI), we performed a meta-analysis of a large sample of
brain-imaging studies aimed at investigating which of
these regions associated with MI-based BMI control were
also recruited during hand MI. As hypothesized, we found
several brain regions common to both tasks (MI and on-
line BMI control) including PMC, M1, and SMA as well as
PPC, insula, and cerebellum. However, we also observed
that BMI-control recruited additional regions in lateral
occipital cortex that overlapped with coordinates of the
extrastriate body area, a region reported to be activated
during MI as well as visual feedback with respect to ongo-
ing movements [i.e., Astafiev et al., 2004; Arzy et al., 2006;
Ninaus et al., 2013].

Sense of Agency for BMI Control

Human action is associated with a SoA, the feeling that
one’s movements and their consequences are self-generated
and not externally produced [David et al., 2008; Gallagher,
2000; Pacherie, 2008] and this has been investigated in
behavioral [Fourneret and Jeannerod, 1998; Tsakiris and
Haggard, 2005] and neuroimaging studies [David et al.,
2007; Farrer et al., 2003; Farrer and Frith, 2002]. Based on a
recent behavioral study, we experimentally manipulated
the visual feedback in half of the trials, by inverting the cur-
sor movement direction with respect to the decoded one. In
this context, our third hypothesis consisted of observing the
coactivation of regions previously associated with the SoA
for bodily actions, together with regions specific for BMI-
mediated action. More specifically, Evans et al. showed that
the SoA for BMI-mediated actions largely relies on the
matching between intentions and the sensory outcome (i.e.,
the visual feedback) [Evans et al., 2015].

The present behavioral data confirm previous findings
obtained using a similar EEG-BMI system [Evans et al.,
2015] and reveal that the SoA for such actions is stronger
for undeviated trials. We also report stronger activation in
subcortical structures (caudate nucleus, putamen) in trials
with a high SoA. A previous BMI-fMRI study indicated
that caudate nucleus and putamen contribute critically to
successful control in self-regulation tasks [Hinterberger
et al., 2005]. We extend those findings by showing that
these regions contribute also to the subjective sense of
BMI control. In addition, we note that the putamen has
previously been implicated in the SoA for executed
actions [i.e., Leube, 2003] and that SoA disturbances have
been associated with pathological conditions affecting
dopaminergic transmission in the caudate nucleus such as
Parkinson disease [Bramley and Eatough, 2005]. Our data
also linked the SoA during BMI control to the ACC, a
region that has previously been linked to the SoA for
bodily movements [Farrer et al., 2003]. We note that Far-
rer et al. exposed participants to spatio-temporal conflicts
between the expected and actual visual feedback, similar
to our paradigm. However, while previous studies tested
the SoA for physical actions characterized by a high

degree of automaticity, “BMI-actions” are learned actions
and require a high degree of attention and cognitive con-
trol. In light of this, it is worth noting that ACC activity is
suppressed when participants acquire an automatic
response through learning, while it is activated when par-
ticipants are instructed to think about their own motor
performance [Jueptner et al., 1997; Lau et al., 2004]. Last,
it should be noted that the activity over basal ganglia
together with that over ACC suggest the involvement of
mechanisms of reward processing. Dopamine neurons in
the basal ganglia code for error detection in reward pre-
diction [Doya, 2000; Schultz et al., 2000] and in line with
this predictive role, it has been shown that activity in the
putamen and caudate is increased when stimulus-
outcome contingencies are learned [Seger and Cincotta,
2005]. Similarly, the ACC is known as a key structure for
conflict monitoring [Botvinick et al., 2004; Van Veen and
Carter, 2002], error-processing [Menon et al., 2001], and
reward signals [Bush et al., 2002].

CONCLUSION

Our results reveal an extended network involved in
BMI control, and point to distinct contributions of differ-
ent cortico-subcortical components enabling MI based
BMI including lateralized control, and the subjective
sense of being in control (i.e., the SoA). Our results on
the SoA may contribute to the development of BMI sys-
tems that allow a more natural experience of feeling in
control and point to the importance of “biomimicry,” that
is, the artificial reproduction of natural conditions hap-
pening during movements in BMI systems [Perruchoud
et al., 2016]. In this context, it would be important to
determine which aspect of sensory feedback contributes
to BMI control. This is worthy of note considering recent
results showing that when no on-line feedback is provid-
ed, learning of self-performance monitoring is delayed
[Schurger et al., 2017]. With respect to BMI control, our
findings show that while signals recorded from motor
and premotor areas via scalp electrodes are sufficient for
delivering command signals, a much larger and distribut-
ed cortical-subcortical network of brain regions is also
involved, including the cerebellum, the lateral occipital
cortex, and the basal ganglia. Future work should be
directed at uncovering which aspect of BMI control each
region of this network contributes to, notably in terms of
learning [Koralek et al., 2012, 2013], achieving [Marche-
sotti et al., 2016], and maintaining the control over BMI-
mediated actions.
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